
FindersKeepers: volunteer instructions 

Thank you for agreeing to help! If you have not already submitted the contact form at the bottom of the FindersKeepers page, please do that 

before carrying on. If you have already registered, you are ready to begin. Please read these instructions carefully, and keep referring to them as 

you work, at least for the first few lists. Let's start with the two Golden Rules: 

 Everything needs a RefNo, Title and Date 

 For help, please write to record.office@derbyshire.gov.uk with FindersKeepers in the subject line. 

Pick a list to work with. 

All the FindersKeepers lists are available to download from our catalogue, from the entries with reference numbers ending in /FK. You can view 

all the remaining lists at http://ow.ly/uWdz2 .  Or you could follow the link from www.derbyshire.gov.uk/recordoffice to the catalogue and click 

on Advanced Search and search using keywords plus *FK in the RefNo field. (Don’t forget the asterisk!)  

When you click on an entry to view the full details, you will see a document to download. Click on it and open it to view on your PC. 

Let us know what you are working on. 

Once you have read through the instructions below, look through the list you have chosen and have a think about how long it is likely to take 

you to work through.  If it looks like quite a big one - or if you are going to work on a batch of smaller lists - please send a quick email 

to record.office@derbyshire.gov.uk with FindersKeepers in the subject line, to tell us the reference number. We will then alter the catalogue 

entry so that it ends with /FKP (which stands for FindersKeepers: Pending). In that way, if other volunteers are searching for lists to work on, 

they will not duplicate your work. 

If the list looks like it won’t take long, feel free just to follow the steps below and email the completed list in to us. 

If the list you are working on is a pdf file, your job is a bit simpler: please create a blank table in Word, and copy-type from the pdf. You might 

want to print it out first. If you find it easier, you can adopt the copy-typing approach with the Word documents, too; or cut-and-paste into a 

new table. However, it's still important to read the rest of the instructions so you know how we want the table to look. 

The instructions assume you use Word 2010. If you have another version, please email us. 

Your mission... is to reformat each entry on the list as four cells in a table. Each row in the table needs a RefNo, a Title and 

a Date.  The Description field is optional.  If you would like to see the kind of transformation we are hoping for, have a look at the end of 

these instructions for an example of an unprocessed list, and the same list after processing.  It gives a kind of Before-And-After effect. 

Start by removing breaks. 

To do this, you need to reveal any hidden formatting: type Ctrl+Shift+8, or click the little button on the top-right of the Paragraph section on the 

Home tab. 

From the View tab, choose Draft View. 

 

Find and replace section breaks by typing Ctrl+H and clicking More, Special, then selecting "section breaks". Put a single space in the Replace box 

and press Replace All. Repeat this process for manual line breaks and manual page breaks. 

 

Next, change the page size: Click Page Layout>Size>A3. 
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Turn the list into a table. 

Select all the entries, using Ctrl+A. 

 

You should now be looking at a table. But it needs headings – four of them. 

To add the headings, right-click the top-left cell, and select Insert Rows Above. Then do it again, so you have two additional rows. 

 

In the top row, type RefNo, Title, Description and Date as headings. In the second row, type the reference number and the collection title. For 

now, the best thing to put under "Description" would be the blurb beneath the title. Cut and paste it in. 

 

FindersKeepers involves a lot of cutting and pasting, so if it is new to you, watch this clip on Youtube. 

You will want to turn off the prompts that get in the way when cutting and pasting.  Click the File tab, then Options. 

 

Under "Date", put the date range for the entire list. If the list is too long to work out the full range right now, leave it blank. But you will need to 

come back to it, because every line of the catalogue needs a date. A reference number and title are also compulsory for every line. If the main 

text can divide neatly into a Title and Description, so much the better – but Description is optional. 

Adjust the columns so that RefNo and Date take up a relatively small space, and the other two fields rather more. If the table is still oddly 

formatted, select it all (Ctrl+A) then click “clear formatting” on the Style menu. 

 

http://www.youtube.com/watch?v=PCZuybvBCp8
http://recordoffice.files.wordpress.com/2014/03/texttotable.jpg
http://recordoffice.files.wordpress.com/2014/03/add-rows.jpg
http://recordoffice.files.wordpress.com/2014/03/blurb.jpg
http://recordoffice.files.wordpress.com/2014/03/options.jpg
http://recordoffice.files.wordpress.com/2014/03/clear-formatting.jpg


Put everything in the proper column. 

The table you just created needs to have reference numbers under RefNo, dates under Date and so on. This means lots of cutting and pasting. 

There are plenty of other things to remember: 

 Combine any text split across cells 

Select several cells with the left mouse button, then click the right button and choose Merge Cells.  Then delete any paragraph marks (they look 

like this: ¶ ) and if necessary cut and paste any other text into the right place. 

 

 Delete empty rows 

Right click a cell in an empty row, then choose Delete... then Delete Whole Row.  By the time you are finished, there should be no empty rows 

in the table at all.  (You would be forgiven for thinking it helps to make the list more readable by leaving a bit of space - but this is not relevant 

right now: you are trying to make things convenient to import into a database, not easy to read!) 

 

If you have needed to merge cells holding the Title/Description information, you will find there are empty cells to the left and right, beneath the 

reference numbers and dates.  You should delete these in just the same way. 

 Sort out the headings 

Headings are also there to make a list more readable.  But there is less need for them in an online catalogue, which can be searched with 

keywords.  Confronted by a heading, your job is to decide whether it is really doing anything useful.  If it isn't, delete it. 

If it is, give it a reference number and a date – otherwise it will disappear into the ether.  You may need to rework some of the text to help it 

make sense, as this example shows 
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Now that everything is in the right column, there are a few more steps to go through: 

 Sort out the dates 

Keep the Date column reserved for years – details of days/months should go under Description instead. If years aren't given, you can use the 

decade, or the century, shortened to "Cent". The words "late" "mid-" and "early" can also be understood by the database, as can "nd", which 

stands for "no date". But that's as far as it goes! If you find that the only date given is "medieval" or "temp Eliz I", move it to Description and leave 

the Date column blank. We will sort it out later. 

Dates should not have commas, so if the date on the list says "1941, 1943-1946", move that to Description and put "1941-1946" under Date. 

Undeniably, this is a faff. But all your work on this will let researchers search by date using the online catalogue. 

 Take blank spaces out, put forward slashes in 

We used to use spaces in our document references all the time, especially if they were separating numbers from letters. However, these blank 

spaces are meaningless to our cataloguing software, so please replace them with forward slashes. Please also delete the slash between two letters 

unless you can see a reason for it to be there. So, for example, a document formerly holding the reference D37 M/E 2/1 now appears on the 

catalogue as D37/ME/2/1.  There is an explanation of this on a blog post entitled “More About the Catalogue Browser”. 

 Deal with references to microfilms, microfiche, CDs and DVDs 

Always put references to these surrogate versions under Description. If the information is only given once, under the series heading, make sure it 

is repeated under Description for each item that is being referred to. 

 Delete the end credits 

At the very bottom of the list will be some initials, dates and other references – you can get rid of these. 

All finished? Thank You! Here's how to let us have the list back 

You can submit your table as an email attachment, to record.office@derbyshire.gov.uk, with FindersKeepers in the subject line.  You can submit 

several at once if you wish, or if you want to be especially helpful, combine all the information from several lists into a single table. 

Alternatively, if you want to avoid clogging up your outbox, use our Google Drive. If you have registered with FindersKeepers, you should have 

received an automated invitation from Google, allowing you access to a folder called Keepers. If you want to submit lists through Google Drive, 

please accept the invitation, and follow its instructions – otherwise, you can safely ignore it. Once you have done that, go 

to https://drive.google.com and click "shared with me", then Keepers. Click "upload", then Files, and finally upload the table to the folder.  We will 

find them there, and import them into CALM in batches, every few weeks. 

 

To compare an unprocessed list with a finished table, please see overleaf. 
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DERBYSHIRE RECORD OFFICE AND DERBY DIOCESAN RECORD OFFICE 
 
  D3640 
 
 HOPE PARISH/TOWNSHIP AND CHURCH  
 OF ENGLAND SCHOOL: RECORDS, 1808 – 1902 
 

 These records were found at Hope School and transferred to 
the Record Office in August 1992 

 
 Hope Parish/Township Records 
 
D3640/1/1 Paper containing vestry meeting minutes 6 Feb 1808-1809 
 1808 and 26 Dec 1809 and minutes of a meeting of overseers 

of the poor 26 Dec 1809 
 
 Parish apprenticeship of poor children (all these 1763-1817 
 documents are in poor condition) 
D3640/2/1 (Parish illegible) apprenticeship indenture of Isaac (illegible) to 

John Longden of Bradwell linenweaver 1763  
 
D3640/2/2 Hope parish apprenticeship indenture of John Toothill of Hope 

to Ellis Barber of Thornhill  
 1813  
 
D3640/2/3-4 Justices’ certificate that William ?Hall is a fit person to whom 

Thomas Middleton may be apprenticed and parish 
apprenticeship indenture of Thomas Middleton to William Hall of 
Sheffield scissor grinder 1817 

 
D3640/2/5 Justices’ certificate that Robert Lees is a fit person to whom 

John Robinson aged 10 of Hope may be apprenticed  1817 
 
D3640/2/6-7 Juctices’ certificate that Robert Lees is a fit person to whom 

Ellen Hall aged 13 may be apprenticed and parish 
apprenticeship indenture of Ellen Hall of Hope to Robert Lees of 
Ashton under Lyme, co Lancaster, weaver 1817  

 
D3640/3/1 Promissory note, Robert Ashton to pay £27.0.0 1821 
 to Hope township overseer of the poor (in poor condition) 
 
D3640/4/1 Poor rate book containing assessments  1845-1848 
 Sep 1845 – Feb 1848 (allowed by the justices Mar 1848).  

Gives occupiers and owners, description of property rated, 
acreage, rateable value, rate assessed.  D3640/4/1/1 
calculations ? related to an assessment  

 



DERBYSHIRE RECORD OFFICE AND DERBY DIOCESAN RECORD OFFICE 
 
  D3640 
 
 HOPE PARISH/TOWNSHIP AND CHURCH  
 OF ENGLAND SCHOOL: RECORDS, 1808 – 1902 
 

 Hope Parish/Township Records (cont) 
 
D3640/5/1 Receipt to constable of Hope for county rate,  1800-1813, 
 sums for warrants etc Sep 1800 and a note of nd 
 a ‘lay’ (rate) for the church 1813, endorsed with the yield of a 

four penny ‘lay’, listing townships of Hope, Woodland, Edale, 
Castleton, Bradwell, Thornhill, Aston, Brough, Offerton, nd (in 
poor condition) 

 
D3640/6/1 Bond relating to William Holme, and his taking 1794 
 possession of ? (missing) called Cartledge in Holmesfield for 

one year between Mar 1795 and Mar 1798 and involving an 
overseer of the poor of Hope (very fragile, in several pieces) 

 
D3640/7/1 List of ‘people who dined’ 1809  
 Headed by the name of the Reverend Mr Ibbotson and includes 

a calculation of cost (in poor condition) 
 
 Assessed taxes 1807, 1817 
D3640/8/1 Assessment for Oct 1807 
D3640/8/2 Assessment for Aug 1817 
 
 Surveyors of highways account books 1876-1883 
D3640/9/1 1876 – 1879 
D3640/9/2 1880 – 1881  
 D3640/9/2/1 notice of audit of account 1881  
D3640/9/3 1882 – 1883  
 D3640/9/3/1-8 associated receipts 1883  
 
 Hope Church of England School 
 
 Attendance registers 1890-1901 
D3640/10/1 Infants May 1890 – Apr 1891 
D3640/10/2 Infants May 1896 – Apr 1897  
D3640/10/3 Girls May 1892 – Apr 1893 
D3640/10/4 Girls May 1900 – Apr 1901  
  



DERBYSHIRE RECORD OFFICE AND DERBY DIOCESAN RECORD OFFICE 
 
  D3640 
 
 HOPE PARISH/TOWNSHIP AND CHURCH  
 OF ENGLAND SCHOOL: RECORDS, 1808 – 1902 
 
Miscellaneous 
 
D3640/11/1 Letter probably to Hope from Stannington 1902 
 Wesleyan Brass Band with terms for playing on 26 June 

(“Coronation Thursday”) 28 May (in poor condition)  
  



RefNo Title Description Date 

D3640 Hope parish/township and school records These records were found at Hope School and transferred 
to the Record Office in August 1992 

1763-1902 

D3640/1 Vestry records  1808-1809 

D3640/1/1 Paper containing vestry meeting minutes 6 
Feb 1808 and 26 Dec 1809 and minutes of a 
meeting of overseers of the poor 26 Dec 1809 

 1808-1809 

D3640/2 Parish apprenticeship of poor children (all 
these documents are in poor condition) 

 1763-1817 

D3640/2/1 (Parish illegible) apprenticeship indenture of 
Isaac (illegible) to John Longden of Bradwell 
linenweaver 1763 

 1763 

D3640/2/2 Hope parish apprenticeship indenture of John 
Toothill of Hope to Ellis Barber of Thornhill 

 1813 

D3640/2/3-4 Justices’ certificate that William ?Hall is a fit 
person to whom Thomas Middleton may be 
apprenticed and parish apprenticeship 
indenture of Thomas Middleton to William 
Hall of Sheffield scissor grinder 1817 

 1817 

D3640/2/5 Justices’ certificate that Robert Lees is a fit 
person to whom John Robinson aged 10 of 
Hope may be apprenticed 1817 

 1817 

D3640/2/6-7 Justices’ certificate that Robert Lees is a fit 
person to whom Ellen Hall aged 13 may be 
apprenticed and parish apprenticeship 
indenture of Ellen Hall of Hope to Robert Lees 
of Ashton under Lyme, co Lancaster, weaver 
1817 

 1817 

D3640/3 Overseer records  1821 

D3640/3/1 Promissory note, Robert Ashton to pay 
£27.0.0 to Hope township overseer of the 
poor (in poor condition) 

 1821 

D3640/4 Poor rate  1845-1848 

D3640/4/1 Poor rate book containing assessments Sep 1845 – Feb 1848 (allowed by 
the justices Mar 1848).  Gives occupiers and owners, 
description of property rated, acreage, rateable value, rate 
assessed.  D3640/4/1/1 calculations ? related to an 
assessment 

1845-1848 

D3650/5 Constable records  1800-1813 

D3640/5/1 Receipt to constable of Hope for county rate, 
sums for warrants etc Sep 1800 and a note of 
a ‘lay’ (rate) for the church 1813, endorsed 
with the yield of a four penny ‘lay’, listing 
townships of Hope, Woodland, Edale, 
Castleton, Bradwell, Thornhill, Aston, Brough, 
Offerton, nd (in poor condition) 

 1800-1813 

D3640/6 Bond  1794 

D3640/6/1 Bond relating to William Holme, and his taking 
possession of ? (missing) called Cartledge in 
Holmesfield for one year between Mar 1795 
and Mar 1798 and involving an overseer of the 
poor of Hope (very fragile, in several pieces) 

 1794 

D3640/7 Miscellaneous  1809 

D3640/7/1 List of ‘people who dined’ Headed by the name of the Reverend Mr Ibbotson and 
includes a calculation of cost (in poor condition) 

1809 

D3640/8 Assessed taxes  1807-1817 

D3640/8/1 Assessment for Oct 1807  1807 

D3640/8/2 Assessment for Aug 1817  1817 

D3640/9 Surveyors of highways account books  1876-1883 

D3640/9/1 Surveyors of highways account book  1876-1879 

D3640/9/2 Surveyors of highways account book (D3640/9/2/1 notice of audit of account 1881) 1880-1881 

D3640/9/3 Surveyors of highways account book (D3640/9/3/1-8 associated receipts 1883) 1882-1883 

D3640/10 Hope Church of England School attendance 
registers 

 1890-1901 

D3640/10/1 Infants May 1890 – Apr 1891  1890-1891 

D3640/10/2 Infants May 1896 – Apr 1897  1896-1897 

D3640/10/3 Girls May 1892 – Apr 1893  1892-1893 

D3640/10/4 Girls May 1900 – Apr 1901  1900-1901 

D3640/11 Miscellaneous  1902 

D3640/11/1 Letter probably to Hope from Stannington 
Wesleyan Brass Band with terms for playing 
on 26 June (“Coronation Thursday”) 28 May 
(in poor condition) 

 1902 

 

 


